
MCUXpresso IDE

=========================
Version 11.3.1 (March 2021)
=========================

* Upgraded: Newer SEGGER J-Link software (v6.98a).

* Upgraded: Newer PEmicro plugin (v4.9.1).

* Added: 88MW320 support.

* Added: K32W041A support.

* Added: i.MX RT1160 support.

* Feature: Added MCU-Link firmware version check in MCUXpresso IDE:
  - When connecting to target, "Probes discovered" will indicate if
    there are debugger probes that would require update;
  - Each discovered probe will clearly indicate (by a warning icon)
    if a firmware update is available;
  - Tooltip on the mentioned probes will indicate the firmware's 
    download location and its version.

* Fixed: [RT1170] Can't download image to RT1170-EVK when 
  SRAM_ITC_cm7 is located as the first item in RAM blocks 
  in Memory configuration editor.

* Fixed: [RT1170][CM4 boot] Error programming flash in SDP or empty
  flash situations.

* Fixed: [RT5xx/RT6xx] wrong image type (at offset 0x24) in 
  generated executable file.

* Fixed: [KW38] Instruction Trace window does not pull the assembler
  instructions.

* Fixed: [K32W041AM] SWO Trace not working.

* Fixed: SDK cannot set default launch config options for Segger.

* Fixed: Exception if the IDE is launched right after installation
  process, having all checkboxes for additional documentation
  selected.

* Fixed: Welcome page not appearing at startup.

* Fixed: Program and Erase Flash shortcuts from Quickstart Panel
  are also launching an unexpected debug session on the end of
  their normal operation.



* Fixed: LinkServer: Modifying from debugger 8-bit or 16-bit data 
  residing at addresses not aligned to 32 bits may alter data beyond
  the intended range up to the next 32-bit address.

=========================
Version 11.3.0 (January 2021)
=========================

* Upgraded: Version v9 of MCUXpresso Config Tools.

* Upgraded: Newer SEGGER J-Link software (v6.88c).

* Upgraded: Newer PEmicro plugin (v4.8.5).

* Upgraded: Eclipse version to 2020.06 (Eclipse Platform 4.16.0 /
  CDT9.11.1).

* Upgraded: IDE now integrates with OpenJDK8.

* Upgraded: GNU ARM Embedded Toolchain to GCC9-2020-q2-update.

* Integrated: GNU test coverage (gcov) and performance analysis
  (gprof) tools and Eclipse plugins.

* Added: i.MX RT1170 B0 support.

* Added: i.MX RT1024 support.

* Added: RT500 B2 support.

* Added: K32W061 support.

* Added: K32W041AM support.

* Added: LPC55S06 support.

* Added: MCU-Link probe debug support.

* Feature: Added Energy Measurement view aiming to replace the 
  Power Measurement view. Main capabilities:
  - The new view comes with the same feature-set as the old Power
    Measurement view;
  - From a GUI perspective, it offers consistent look & feel with
    other views that display and controls graphs (e.g. Global 
    Variables, SWO-related views);
  - Compatible with existing LPCXpresso boards having on-board 
    power measurement circuits;
  - Power and energy estimation capability: In order to enable
    power/energy measurement/estimation the user should add a 



    reference voltage in the Config tab section from Energy 
    Measurement view. For convenience and more precise measurement,
    the user can press "Read from target" which will automatically
    generate a reference voltage computed as an average value (of 
    the voltage) measured for the last 500msec. Energy and power 
    will be displayed in the status line of the plot area, showing 
    the min/max/average power values and the energy value for the 
    measurements visible in the graph, or over a particular time 
    range selection.
  - Multiprobe and multiview support: the feature is capable to 
    open multiple views, each view can be connected to a different
    probe (that is capable to measure analog). The probe can be 
    selected from Probe Discovery feature available in the Energy
    Measurement view toolbar.
  - Data collecting during an out-of-debug session and also during
    an active debug session;
  - Data collecting with an active debug session while the core is
    in debug mode. Behavior is controlled via toolbar buttons;
  - Configuration of the server-side (rltool) and of the IDE using 
    the Config tab within the view;
  - Import/Export data functionality for offline analysis: (buttons
    on the Energy view toolbar). The user is able to save (Export
    data, in a zip format) the data collected within the view,
    having the possibility to load the saved data (Import data)
    later, in the same view or another one. Loading saved data in
    the Energy Measurement is not requiring physical connection to
    the target;
  - Extended LPC-Link2 support for all targets having onboard
    measurement circuit: LPCXpresso546x8/540xx/54S0xx,
    LPCXpresso54102, LPCXpresso51U68/54114, QN90x0/JN518x/K32W0x1.
    As a side note, if there is any other LPC-Link2 board having
    power measurement capability, the user can use an existing
    configuration (and change the resistor value if necessary);
  - See MCUXpresso_IDE_Energy_Measurement.pdf (or Help -> Help
    Contents) for details.

* Feature: Auto-debug slave project(s) for multicore projects option
  becomes default option for multicore debug purpose (for LinkServer
  debug connection only). That means, in the case of multicore
  projects on which master project refers one or several slave
  projects, debug sessions will be automatically started for slave
  projects after initiating debug with the master project.
  Option is set by default on: Window -> Preferences -> MCUXpresso
  IDE -> Debug Options -> LinkServer Options -> Miscellaneous ->
  Enable Auto-debug slave project(s) for multicore projects.
  If you don't want to have this feature enabled (so if you want to
  start debug sessions for each core independently), uncheck this
  option.
  Similar, Auto-debug slave project(s) for multicore projects option
  becomes default option for multicore debug purpose for PEmicro 



  too. Option is set by default on: Window -> Preferences -> 
  MCUXpresso IDE -> Debug Options -> PEMicro Options -> Enable 
  Auto-debug slave project(s) for multicore projects.

* Improvement: Enhance SWO views:
  - SWO Config: added new Tab for data traffic statistics, 
    configuration for ITM Stimulus ports
  - SWO Profile: added samples and details tabs
  - SWO Data: added plot (similar to Global Variables)
  - SWO Stats: moved inside SWO Config
  - ITM Console: added one tab for each stimulus port

* Improvement: [RT600] Clean up on RT600 flash drivers:
  - Add drivers for MXIC_OPI connected via FlexSPI_A port
  - Add drivers for QSPI drivers (SFDP) connected via FlexSPI_B port
  - Add drivers for QSPI drivers (SFDP) connected via FlexSPI_A port
  - Remove MIMXRT600_SFDP_* drivers generated by the old project 
  (SDK now references the new drivers).

* Improvement: Drop-down boxes from several tables require two user
  operations for reaching the actual items from the list. Reduced
  now to a single operation (single click).

* Improvement: Extend CLI functionality - Add new command to list
  SDK info:
  -filter=<string> : filters the available information based on 
     regex expression string. e.g. -filter=K64 will display all 
     data containing K64 string
  See SDK command line documentation within the layout
  (MCUXpresso_SDK_Command_Line_User_Guide.pdf).

* Improvement: Added Instruction Trace support for LPC55S69.

* Improvement: Merge c_include path section into cpp_include path
  section for cpp project in project settings.

* Improvement: New project wizard is now capable to handle HW with
  dual master/slave roles (i.e. RT1170). From SDK Wizard page, any 
  core can be selected according with the slave/master SDK 
  description, plus it can be selected as standalone (application).

* Improvement: Community forum accessible now from the main toolbar
  too (together with the older link from Help->MCUXpresso IDE
  support forum). The default selection will open the community web
  inside the IDE. If you want to set the default browser as
  external browser, use Window->Preferences->General->Web browser
  ->"Use external web browser".

* Fixed: [RT500] QSPI flash drivers: driver was incorrectly using 
  QSPI DDR instead of SDR.



* Fixed: [RT500][RT600] J-Link launch config default resets:
  - Re-enable resets in J-Link launches for RT500/RT600
  - The most recent J-Link versions properly handle resets for 
  RT500 & RT600 devices.

* Fixed: [RT500] Unable to Restart flash-based session on EVK
  RevC1 board.

* Fixed: [RT685] "Unsupported or unrecognized format error" dialog
  when using the installed SDK.

* Fixed: [LPC55S69] Implemented DWT (Data Watchpoint and Trace)
  component for ArmV8. This fixes the SWO Data trace not working
  issue.

* Fixed: [LPC55S06] SWO support.

* Fixed: [LPC55xx] LinkServer debug cannot recover LPC55xx from 
  deep sleep.

* Fixed: [LPC845] Debug fails when SRAM is split into sub-blocks.

* Fixed: [LPC4337] Flash programming over JTAG not working on the
  M4 core.

* Fixed: [LPC54114] SWO Trace is not working with PEmicro.

* Fixed: [FRDM-K64] Removed unexpected warning reported in map file
  in a project.

* Fixed: [JN5189/QN9090/KW32W041AM] Improve OOB experience with 
  (factory) erased devices.

* Fixed: IDE 'Utility' menu does not work for linked Folders.

* Fixed: Defined symbols are added prematurely (even when no 
  component is selected in NPW.

* Fixed: Selection of a driver in NPW makes the Library Type and 
  Floating Type to become empty.

* Fixed: "ERROR: fatal error: board.h: No such file or directory"
  error reported if build a new created project with no board 
  support.

* Fixed: Library type is not changing correctly when using SDK
  Wizard.

* Fixed: SDKs for older LPCs failing to set CRP up correctly.



* Fixed: Outline view displays empty table header when selecting an
  SDK.

* Fixed: Issues when uninstalling a SDK plugin. Now "Installed
  SDKs" and "Install MCUXpresso SDK" views are in sync and report
  the right installation status of a SDK.

* Fixed: On explicit include paths in the project setting, the 
  include paths are mixed between asm and c type.

* Fixed: Outline view displays empty table header when selecting an
  SDK.

* Fixed: Null pointer exception on generating example xml.

* Fixed: Build error when use MCUXpresso IDE command line with 
  non-existing include.

* Fixed: SDK command line: pre and/or post build steps options not 
  available in example.xml file.

* Fixed: J-Link scripts needed by SDK examples are not copied 
  correctly when installing the SDK from a folder.

* Fixed: MCUXpresso linked projects compile errors on multicore 
  platforms.

* Fixed: Compile errors reported on a project imported from a
  generate example.xml. Also fixed the CLI build failing on the 
  same example.xml scenario.

* Fixed: Unexpected memory usage reported (over 100% occupied 
  memory) by Image Info.

* Fixed: Programming empty pages for ERASE_WO devices when flash
  hashing is enabled.

* Fixed: 'debug interface type' identification shown in the "Debug
  messages" console.

* Fixed: "Terminate" operation does not kill the redlinkserv.exe 
  process.

* Fixed: "Terminate" button appears disabled after the first
  "Suspend" for PEMicro and J-Link debug connection.

* Fixed: J-Link auto selection results in not working connection.

* Fixed: Flash programming using J-Link via JTAG.



* Fixed: The running environment (PC/SP) for RAM applications is now
  properly initialized by the debugger when using J-Link/PEmicro.

* Fixed: Debugger Console output stops working when debugging
  secure project.

* Fixed: Error reported when SWO clock speed dialogue cancelled.

* Fixed: FreeRTOS tasks list not populated correctly in some
  situations.

* Fixed: SVD viewer shows-up with empty peripherals list.

* Fixed: Live Variables: Unable to create expression with casts.

* Fixed: Global Variables: T0 will remain -0 while moving the
  Graph to the right.

* Fixed: [Dark Theme] highlighting makes text unreadable.

* Fixed: [Dark Theme] Text is not visible for Blocked jobs in 
  FreeRTOS.

* Fixed: [Dark Theme] Peripherals view - some registers have yellow
  background making it hard to read.

* Fixed: [Dark Theme] Line highlighting in editor makes variables
  text unreadable.

* Fixed: [Dark Theme] Display issue for the "Probes discovered"
  window on Mac.

* Fixed: [Dark Theme] Low contrast on text vs. background when a 
  word is high-lighted by having cursor selection on it.

* Fixed: [Dark Theme] Manage SDK Components window is not updated.

* Fixed: [Dark Theme] Various improvements on Disassembly, Memory,
  Peripherals, headers in views, editor, git plugin.

* Fixed: [Dark Theme] Install plugin SDKs window shows white
  rectangles around icons.

* Fixed: [Dark Theme] Line number background is too bright.

* Fixed: [Dark Theme] Install MCUXpresso SDK view shows white 
  background while selecting table headers.

=========================



Version 11.2.0 (July 2020)
=========================

* Upgraded: Eclipse version to 2019.12 (Eclipse Platform 4.14.0 / 
  CDT9.10.0).

* Upgraded: GNU ARM Embedded Toolchain to GCC9-2019-q4-major.

* Upgraded: GNU make 4.2.1 is now integrated on IDE on all OS-es.

* Upgraded: Version v8 of MCUXpresso Config Tools.

* Upgraded: FreeRTOS TAD synchronization with FreeRTOS 202002.00.

* Upgraded: newer SEGGER J-Link software (v6.80d).

* Upgraded: newer PEmicro plugin (v4.6.9).

* Added RT500 B0 support.

* Added flash programming support for QN9090/JN5189.

* Added KW37/KW38/K39 B0 support.

* Improvement: [RT500/RT600] Extended flash drivers to support boards
  potentially wired in a different way from the EVKs with regards to 
  the reset pin used for the external flash device.

* Improvement: [RT500/RT600] Flash erase performance of RT600 rev B0 
  flash driver (~30% speed increase).

* Improvement: 'Delete' option added for plugin SDKs. Now the removal
  option should be similar with the file system SDKs.

* Improvement: Added Help -> "MCUXpresso IDE Save Info For Support" 
  option intended to gather enough information to help reporting an 
  issue: 
  - MCU IDE installation details
  - Files from workspace
  - Information about Installed SDK
  - Workspace log file
  - Content of the Console View
  User is encouraged to use this option when reporting an issue and 
  to also attach the generated zip file to help development team to
  easier trace the reported problem.

* Improvement: added new control to manage the maximum number of 
  child expressions that are evaluated in advance by the Live 
  Variables service. This improves the Global Variables window 
  responsiveness for instance when large structures are displayed.



  New control available on Eclipse Preferences -> MCUXpresso IDE 
  -> Debug Options -> "Number of subexpressions proactively 
  evaluated by Live Variables service". Default is 2 set as depth.

* Improvement: expressions added in Global Variables are now 
  persistent between debug sessions.

* Fixed: Error reported while importing SDK example and changing to 
  Newlib (semihost).

* Fixed: LinkerScript awareness reports fails on /DISCARD/ sections.

* Fixed: IDE freeze and high CPU power consumption while debugging 
  with Segger debug probe and disconnecting the USB cable.

* Fixed: SDK import project example copies wrong header file in the 
  case of multiple files with the same name.

* Fixed: Unticking the "Redirect SDK PRINTF to C library printf" does
  not reset the ticking settings.

* Fixed: [LPC11U68] A modified register in peripherals view alters 
  other registers.

* Fixed: [RT600] Debug error using LinkerServer if RT685 previously 
  went to deep sleep state.

* Fixed: [RT600] Unable to use "Restart" for debug session on RT600.

* Fixed: [LPC43xx] "Wrong field format" displayed for SPI peripheral
  registers on LPC43xx.

* Fixed: [RT1170] breakpoint support for CM4.

* Fixed: "Hide Installed" within SDK installer view should be 
  unchecked by default.

* Fixed: Include directory path for the proper newlib.h is missing 
  when newlib-nano spec is used.

* Fixed: Global Variables showing negative timestamps after "Clear 
  Data" is used.

* Fixed: Exception thrown after trying to delete a closed project.

* Fixed: SDK plugins generated with the IDE contains keywords of 
  examples that are missing in the SDK package.

* Fixed: ELF parsing issue which in some particular circumstances 
  could cause incomplete flashing of programs generated using 



  user-defined linker scripts (for example tfm SDK examples).

* Fixed: Linker script error related to "OVERLAY" keyword.

* Fixed: Internal error displayed when creating a new ldt file in 
  MCUX.

* Fixed: Empty tooltip for "Global Variables" View when adding 
  variables.

* Fixed: Linker script parsing error reported as: 
  "missing ';' at '}' ".

* Fixed: Exception shown when renaming a project after a debug 
  session ended.

* Fixed: Missing board picture when a SDK is selected within "SDK 
  installer" on Ubuntu.

* Fixed: Removed board related memories on "New Project Wizard" when
  "Empty board files" option is selected.

* Fixed: issue when Global Variables list is empty when going into 
  debug mode.

* Fixed: xpsr registers for which the values cannot be changed for 
  Cortex M0 boards.

* Fixed: null pointer exception shown when displaying Globals 
  Variable view in NonStopMode.

* Fixed: freeze reported when hovering over a large size symbol.

* Fixed: empty tooltip for Global Variables View when adding 
  variables.

* Fixed: various UI widgets to correctly display the dark theme.

* Fixed: the issue when removed variables were continuing to plot 
  data.

* Fixed: "Remove Selected Variables" always removes all added global
  variables. This was happening when global variables were added in 
  Global Variables view using "Add new expression".

* Fixed: Japanese/Chinese font issues on MCUXpressoIDE - this was
  fixed by the updated eclipse version.

* Fixed: issue (hang) when display large structures while debugging.



=========================
Version 11.1.1 (Mar 2020)
=========================

* Fixed issue with file path handling when importing examples
  or creating new projects with certain SDKs (previously made
  available as a hotfix to IDE v11.1.0 via Eclipse update system)

* Fixed issue that prevented text zooming in Editor View

* Fixed issue that caused deletion of most compiler defines if
  the MCU package for a project were changed

* Updates to linker script file awareness, including
  - Fixed issue handling situation where symbols are quoted
  - Removed requirement for MEMORY command to provide access
    attributes

* Updates to map file awareness, including
  - Fixed issue with handling of ld's PROVIDE keyword

* Fixed issue with linker script generation related to placement
  of symbols for .ARM.exidx section (which could trigger issue
  with C++ exceptions)

* Restructured way eGIT plugin integrated into IDE (to allow
  updating by the user). Supplied version also updated to v5.6.0

* Updates to allow LinkServer debug connections (ie CMSIS-DAP) to
  i.MX RT6xx "rev B" silicon. Note that these changes mean that
  earlier i.MX RT6xx silicon can no longer be supported

* Updates to LinkServer debug to provide support for debugging
  Kinetis KE0x. Note that manual changes to SDK 2.7.0 or earlier
  are required for this to be enabled

* Preliminary LinkServer support for i.MX RT1170 devices

* Fixed sector size issue with LinkServer flash driver for
  Kinetis KM3x devices

* Fixed issue that prevented launch configuration creation
  (and hence debug) for multicore projects for preinstalled parts
  (LPC43xx and LPC54xxx)

* Fixed issue with Peripheral View incorrectly handling 32-bit
  bitfields within peripheral registers

* Fixed issue with Registers View such that modifying fields in
  xpsr could incorrectly modify other fields



* Added mechanism to Preferences to allow default reset settings
  used when creating SEGGER launch configurations to be overridden
  for specific devices

* Updated integrated version of MCUXpresso Config Tools to v7.0.1
  - TEE tool: Displays correctly inaccessible regions in "Memory
    attribution map" view

* Upgraded to a later version of the P&E Micro plugin (v4.5.3)

* Upgraded to a later version of the SEGGER J-Link software (v6.62d)

=========================
Version 11.1.0 (Dec 2019)
=========================

* Upgraded underlying Eclipse Framework to 4.12.0.v201906 / CDT9.8.1

* Upgraded supplied GNU ARM Embedded Toolchain to GCC8-2019q3-update

* Added support for MCUXpresso SDK v2.7

* Upgraded integrated version of MCUXpresso Config Tools to v7

* New Welcome View, providing an improved out-of-box experience
  for new users. The IDE now also opens for the first time at a
  larger default window size, improving usability without the need
  for resizing

* New "plugin SDK" system provides an easy-to-use mechanism for
  simplified installation and management of MCUXpresso SDKs

* Reduced code size of debug builds of SDK projects by decreasing
  the overhead of the assert() function, which is commonly called
  by SDK functions. This has been done by the addition of
  "-fmerge-constants" and "-fmacro-prefix-map" compiler options
  to project compiler optimization settings

* Added support for more complex specification of dependencies
  between SDK components. This allows some components (in
  particular, middleware ones) that previously could only be
  accessed through SDK examples, to now be added to projects
  and configured, either as they are created by the new project
  wizard, or for existing projects via "Manage SDK Components".
  Note that this functionality requires SDK 2.7

* Various enhancements to "Installed SDKs" View, including:
  - New tabs provide easy access to the list of boards and devices



    that are installed into IDE, in addition to the actual SDKs.
    Right click menu on a board or device also allows new project
    wizard (and, for boards, import example wizard) to be run
  - Detailed information on contents of selected SDK is now
    displayed in Outline View
  - Improved loading of SDKs, including refreshing, improving
    performance and fixing memory leaks
  - Copy/paste of SDKs now allowed between View and OS filer, as
    well as between different IDE instances

* Fixed an issue with sorting of boards in SDK wizards

* Fixed an issue with handling of combined secure / non-secure
  with multicore projects

* Fixed issue with "Manage SDK Components" removing &quot from
  C++ Symbols in .cproject file

* Various fixes and enhancements to SDK Editor / Creator, to
  support "user board SDKs" to act as an extension to a standard
  MCUXpresso SDK

* Various fixes and enhancements to Image Info View. In particular:
  - Further improvements to load times
  - Added ability to double-click on memory region in Memory Usage
    tab and jump to that region in the Memory Contents tab
  - "Load" from project button now provides a drop-down to allow
    direct loading of info from multiple build configurations into
    multiple Image Info Views
  - Regular expressions now supported in "Search..." box
  - "Open 'main' symbol" button implemented on toolbar
  - Improved support for projects outside the workspace

* Various improvements and fixes to map file awareness, including:
   - Improved handling of C++ projects
   - Fixed an issue with handling expressions containing parentheses

* Various improvements and fixes to linker script file awareness,
  including improved handling of libraries specified in script

* Various improvements to the managed linker script system:
  - Standardized set of symbols now generated for sections
  - Fixed an issue with LMA being incorrectly set in some
    circumstances for sections that do not have a real load address
    (e.g. .bss). Although this did not prevent the generated image
    from working, it could cause, for example, erroneous
    information in Image Info View
  - Plain load image functionality now supported for RT6xx devices
  - LinkServer FreeRTOS debug config rodata now placed by script,
    when appropriate



* Increased default java memory settings (-Xms, -Xmx) in
  mcuxpressoide.ini file. This means the IDE may now use up to 2GB
  by default

* Windows build tools now provide 'mv' command

* Added MCUXpresso Dark Theme, providing better support for IDE's
  tailored set of Views being used in dark mode

* Improved organization of MCUXpresso IDE preferences, in
  particular Debug related ones

* Project decorators implemented in Project Explorer View to
  indicate Master/Slave and Secure/Non-secure projects

* Standardized graphing technology used by SWO Interrupt trace and
  by Global Variables View

* Improvements to LinkServer flash driver performance for many
  devices. In particular, most flash drivers now implement a
  "verify-same" hashing mechanism to remove the need to
  erase/reprogram when the memory being programmed already has the
  required content. This can provide a noticeable improvement in
  debug startup time, particularly when repeatably debugging large,
  non-changing images

* Required debug probe can now be selected by double-clicking
  on it in the "Probes discovered" dialog

* Global Variables View now uses a check-box system to select
  variables to be displayed in graphs within the details pane

* Improved handling of certain variable types, along with signed
  versus unsigned variables, within the Global Variables View

* Fixed an issue with display of large arrays in Global Variables
  View with SEGGER and P&E Micro debug connections, when Live
  variables are enabled

* Various fixes and enhancements to the Peripherals View, in
  particularly some registers being marked as inaccessible when
  single stepping

* Fixed an issue with Disassembly View going blank after Restart,
  with LinkServer debug connections

* Fixed an issue with flash programming with P&E Micro probes when
  filename or path contains a space



* Fixed various memory leaks triggered during debugging

* Fixed an issue with decoding correct stack pointer to be used in
  Faults View

* When debugging secure / non-secure projects, you can now set
  breakpoints in CMSE functions and view source when breakpoints hit

* Reduced the RAM footprint of the FTFA_1K.cfx LinkServer flash
  driver, to prevent issues on some smaller RAM devices that make
  use of this driver (e.g. MKE14Z32)

* Additional and improved Linkserver connect scripts for RT10xx
  devices, which in particular reset the FlexRAM sizes to default.
  Note that for some devices, these will only be picked up by
  default if you are using an appropriate SDK 2.7

* Fixed an issue that could prevent LinkServer SWO trace and power
  measurement from working on Linux platforms in some circumstances

* Fixed an issue with setting wirespeed in LinkServer launch
  configurations

* Cleaned up various layout issues with launch configuration editor

* Updates to product and installer to allow better compatibility
  with newer versions of Ubuntu. Note that our supported Linux
  platforms remain Ubuntu 16.04 LTS and 18.04 LTS

* Updates to support new devices, including LPC551x, K32L2A and
  K32L2B families

* NXP LPC-LINK2 CMSIS-DAP firmware soft-loaded by IDE updated to
  v5.361

* Upgraded to a later version of the P&E Micro plugin (v4.4.1)

* Upgraded to a later version of the SEGGER J-Link software (v6.54c)

=========================
Version 11.0.1 (Aug 2019)
=========================

* Updates to allow LinkServer debug connections (ie CMSIS-DAP) to
  LPC55S6x "rev 1B" silicon and other devices that implement "debug
  mailbox request" mechanism. Note that these changes mean that
  some pre-production LPC55S6x silicon can no longer be supported

* Updates to support new devices, including K32L3A and i.MX RT1010



  families

* Link to https://mcuxpresso.nxp.com now provided in New Project
  and Import SDK example(s) wizards, improving accessibility for
  downloading additional SDKs

* Updates to map file awareness, including improvements to loading
  speed

* Fixed various issues with Image Info View

* Fixed issue with floating point options being incorrectly set
  for SDK example projects with C++ nature in some circumstances

* Extended "include paths" indexer fix implemented in IDE v11.0.0
  to also work with library projects

* Fixed issue with SDK multicore examples importing with managed
  linker script settings not being configured correctly in some
  circumstances

* Fixed memory leak in Installed SDKs View when regeneration of
  part support info triggered

* Managed linker script mechanism now generates references to
  "CodeQuickAccess"", "DataQuickAccess" and "RamFunction" input
  sections (required by some SDK examples/ drivers) in default
  .data output section

* Fixed issue with Debug Shortcuts in QuickStart Panel incorrectly
  selecting attach/debug option in some circumstances

* Fixed various minor issues with GUI Flash Tool

* Fixed issue with Global Variables View slowing down debug launches
  with C++ projects

* Fixed addresses > 0x80000000 issue with Heap and Stack Usage View

* Fixed issue with Global Variables View graphs updating when
  target suspended

* Fixed issue with Peripherals View with LPC17xx devices,
  particularly effecting display of certain enumerations

* Fixed issue with Peripherals View refresh. This could cause some
  registers to sometimes be erroneously displayed as unavailable

* Fixed issue with LinkServer launch configuration wirespeed setting
  being ignored in some circumstances



* Updated the way the IDE autodetects installed SEGGER software.
  This is required due to changes SEGGER have made to the default
  options of their Windows installer in v6.46 and later of their
  software

* Fixed issue with P&E and SEGGER implementations of live variables
  service (required to support live update of globals in Global
  Variables View). This issue could provoke problems in some
  circumstances when debugging via these probes including slow
  debug performance and failure to display locals inside the
  Variables View

* Fixed issue with display of large arrays when using P&E or
  SEGGER debug connections

* Fixed issue which could trigger error when manually creating a
  J-Link launch configuration

* Upgraded to a later version of the P&E Micro plugin (v4.2.5)

* Upgraded to a later version of the SEGGER J-Link software (v6.46k)

* Fixed build issue with MCUXpresso IDE v11.0.0 User Guide which
  caused last chapter ("Appendix – Additional Hints and Tips") to
  be merged into the previous chapter ("Multicore Projects") as
  section 19.6 onwards. Actual content of manuals provided with
  IDE v11.0.1 otherwise unchanged from v11.0.0 manuals

=========================
Version 11.0.0 (Jun 2019)
=========================

* Upgraded underlying Eclipse Framework to 4.10.0v201812 / CDT 9.6.0.

* Upgraded supplied GNU ARM Embedded Toolchain to GCC8 (2018q4-major)

* Windows version of product now only runs on Win64 (IDE v10.3.1 and
  earlier ran on Win32 & Win64 platforms). Note that this change has
  been driven by the fact that Eclipse framework is now 64-bit only.
  [ Ubuntu and MacOS versions of product already only ran on 64-bit
    platforms.]

* Updated version of "busybox", used on Windows to provide a
  Unix-like layer for GCC tools to run under, to "GNU MCU Eclipse
  Windows Build Tools" v2.12 (64bit)

* Added support for MCUXpresso SDK v2.6



* Upgraded integrated version of MCUXpresso Config Tools to v6

* Revamped Develop Perspective with some new and additional views
  shown by default. Also decluttered by removal of some less
  commonly used views. Most of the removed views can be added back
  via the new 'Analysis' menu

* New "Image Info" View improves and extends on the functionality
  previously provided by the "Symbols Browser" view, giving the
  following analysis of a project build:
  - Overall memory usage
  - Content of memory regions
  - Static call graph, including stack usage information

* New "Heap and Stack Usage" view provides ability to track heap
  and stack usage during debug of baremetal projects

* Implemented "editor awareness" for linker map files, linker
  scripts and linker script templates, providing syntax coloring
  as well as navigation of file contents via the Outline view

* Improved display of components in New Project Wizard and Managed
  Components dialog. Display of different component types is now
  tabbed, with an additional summary of the components selected

* The New Project Wizard will now open the main source file in the
  Editor view after project creation

* When importing a single SDK example, the wizard will now attempt
  to open the main source file in the Editor view after project
  creation. This functionality can also be enabled when importing
  multiple examples through a workspace preference

* Improved support for Cortex-M33 Secure / Non-Secure projects.
  Improvements include :
  - Secure and Non-Secure projects more closely linked from build /
    project configuration point of view
  - Debugging Secure project will automatically build Non-Secure
    project and program it into flash, before launching Secure
    project debug session
  - Symbols for Non-Secure project automatically loaded into debug
    session to allow user to step from Secure world into Non-Secure
    (with source code visibility)
  Note that these improvements also require SDK v2.6 for the MCU
  being targeted

* Improved Launch Configurations for LinkServer. Main user impact
  is that this allows a more friendly way of editing launch
  configuration settings. Some launch configuration functionality
  now also provided in "standard" Eclipse/CDT tabs rather than



  in LinkServer specific manner. LinkServer Launch configurations
  from older IDE versions will be automatically converted to the
  new format

* New launch configuration tab (for all debug probe types) to allow
  loading of debug symbols from additional images (in addition to the
  ones from the main image being debugged)

* Improvements to performance of single stepping for LinkServer
  debug connections

* Implemented support for SWO Trace on Cortex-M33 based MCUs

* "Live Variables" functionality inside the Global Variables view
  now supported using SEGGER J-Link and P&E Micro debug probes (in
  addition to LinkServer debug connections)

* FreeRTOS TAD functionality now directly implemented within the
  IDE, rather than being a separate plugin
  - Improved look and feel to better match rest of IDE
  - Timeout period for FreeRTOS TAD increased, to help prevent
    reading of data failing on slow debug connections. IDE
    preference also added to allow timeout period to be changed
  - Fixed issue with Runtime not showing when compiler optimizations
    turned on
  - Fixed issue with Timer List with FreeRTOS 10.2 release

* Fixed issue with IDE losing C library include paths. This did
  not prevent projects from building but meant that indexer-related
  functionality reliant on these paths would not work correctly
  (for instance trying to open a C library include file from the
  editor). This issue could also cause Newlib projects to sometimes
  appear to be using Redlib include files.
  Note: Existing projects can be "fixed" using Tools->Fixup Parsers
  option on the Project Properties view's context sensitive menu

* New projects now compile with the --fstack-usage option by
  default (needed for callgraph functionality in the "Image Info"
  view)

* Quickstart Panel - Quick Settings menu can now indicate current
  value for Debug Console, Floating Point and Library settings for
  current build configuration of selected project

* New projects now link with --cref option by default (increasing
  level of information provided in linker map files)

* Improved performance of installing/loading SDKs, largely by
  re-architecting the way that SVD peripheral definition files from
  the SDK are processed



* Installed SDKs view updated so that detailed information on
  contents of selected SDK is hidden by default, but with new
  Hide/Show button to display when required

* SDK default folder mechanism updated to install SDKs into an "02"
  subdirectory by default. This means that SDKs installed by
  IDE v11.0.0 will not be visible to older versions of the IDE

* Improved ability to select debug console type (semihosting vs UART
  vs any preference specified by example definition) when importing
  SDK examples. This is particularly useful when multiple projects
  are selected for importing at the same time

* Tweaked code generated for main() by New Project Wizard for SDK
  projects such that the infinite loop at the end of the function
  can be successfully single stepped at the source level

* Fixed issue with default compiler options set by SDK New Project
  wizard when creating C++ projects. Such projects now also created
  with "cpp_config.cpp" file containing minimal implementations of
  the new/delete operators and the verbose terminate handler for
  exceptions suitable for embedded use. This brings SDK C++
  projects inline with C++ projects created with the New Project
  Wizard for preinstalled parts

* Some performance improvements when making a board selection in
  New Project Wizard and Import SDK example(s) wizard

* Fixed issue with IDE incorrectly warning about overlapping memory
  regions when importing some SDK examples, when the memory regions
  are actually just adjacent

* Fixed issue with IDE being unable to show the context sensitive
  menu in the Project Properties view for makefile projects in some
  circumstances

* Fixed issue with handling of part support information for MCUs
  which are supported by internal part support, but for which an
  SDK exists and has been installed into the IDE

* Various updates and clean up of icons. In particular, new icon
  for "LinkServer" now used in various places instead of general
  MCUXpresso IDE one

* Fixed issue with various tables displayed by IDE failing to
  display "..." to indicate truncation, when amount of text to
  display exceeds space currently available in column

* Various fixes to SDK Editor / Creator



* Fixed issue with managed linker script mechanism when building
  master projects linking in slave projects containing data with
  larger than normal alignment

* Fixed issue with managed linker script mechanism which was causing
  some sections (such as .bss) to be erroneously assigned
  unnecessary load addresses

* Fixed issue with section name wildcards used in managed linker
  script mechanism , which could prevent __BSS/__DATA macros from
  working as expected in some circumstances

* On Managed Linker Script page of Project Properties, IDE now
  autoconverts any "\" directory separators entered into
  "Script path" to Unix style "/" expected by the linker

* Added implementations of inverse hypobolic functions to Redlib
  (acosh/acoshf, asinh/asinhf and atanh/atanhf)

* Improved Redlib definition of HUGE_VAL (and other related defines)
  in math.h. Also updated way float_t defined

* arm_acle.h header file now on the search path for projects linking
  against Redlib (providing various ARM C language extension
  intrinsics). Previously this was only available for Newlib linked
  projects

* IDE now prioritizes use of IDE supplied LinkServer flash drivers
  over any contained in installed SDKs (rather than the other way
  around). This behaviour can be reverted if necessary using an IDE
  workspace preference

* Fixed various issues with creation of multiple launch configurations
  for a particular build configuration in a project

* Fixed issue with creation of launch configurations if previous
  attempt was cancelled

* "Attach-only" debug sessions no longer trigger a build before
  starting the debug connection (as long as image has already built)

* Improved size and layout of Launch Configuration Selection Dialog
  (displayed when project contains launch configurations for
  multiple probe types)

* Fixed issue with display of cycle counters in Registers View

* Fixed issue with GUI Flash Tool via LinkServer with LPC51U68
  and KL28 MCUs



* Fixed issue with debug restart with QN9080 via LinkServer

* Fixed issue with LinkServer FreeRTOS thread awareness with
  Cortex-M33 based MCUs (and CM33 aware versions of FreeRTOS)

* Implemented preliminary support for carrying out SWO Trace using
  CMSIS-DAP probes that implement "CMSIS-SWO commands" (as opposed
  to the bespoke SWO support implemented by NXP's LPC-Link2
  CMSIS-DAP firmware). This has currently only received limited
  tested using ULINKplus probes with CMSIS-DAP v1.x.x firmware.
  Note : MCUXpresso IDE does not support the use of WinUSB
  endpoints as provided by CMSIS-DAP v2.x.x firmware

* New IDE workspace preference to allow debug launch configurations
  for SEGGER J-Link probes to be created with FreeRTOS thread
  awareness already enabled (off by default)

* Upgraded to a later version of the P&E Micro plugin (v4.1.3)

* Upgraded to a later version of the SEGGER software (v6.44i)

=========================
Version 10.3.1 (Feb 2019)
=========================

* Improvements to support for i.MX RT600 MCUs

* Improvements to support for LPC5500 MCUs

* Added managed linker script and LinkServer debug support for
  i.MX RT1015

* Fixed issue with permissions within IDE installation directory
  on MacOS and Ubuntu which could cause failure of FreeRTOS TAD
  plugin and also prevent installation and update of third party
  plugins (e.g. from Eclipse Marketplace)

* Managed linker script mechanism now includes libgcc.a in the
  list of libraries to be linked against when using Redlib
  (to resolve any runtime support functions generated by
  compiler that have no specific implementation in Redlib)

* Improved error checking in Memory Configuration Editor

* Managed Linker Script settings in Project Properties now
  more thoroughly checks alignment / region size when calculating
  "Default" stack size - preventing potential issues with
  incorrect stack alignment



* Fixed issue with handling of "preinclude file" option when
  importing "Connectivity" example projects available in SDKs for
  certain MCUs (such as Kinetis KW devices)

* Fixed issue with the SDK project wizards such that new projects
  could, in some circumstances, inherit memory configuration
  information from a previous instance of the project wizard

* Fixed issue when importing SDK example projects that
  could cause projects to lose part of their configuration

* Fixed issue with "Select All" option failing when trying to add
  SDK Middleware components to a project with some SDKs

* Improved handling of incorrect SDKs

* Fixed issue with Project Properties right-click menu which
  could cause it to fail to display for non-SDK projects

* Various fixes to SDK Editor / Creator

* Binary Utilities options are now disabled in certain cases for
  "CDT virtual nodes" in the Project Explorer view (when such
  nodes are pointing to "files" that don't actually exist in
  the file system)

* Fixed issue in Fault Views which could cause certain fault
  registers to be displayed when they were not valid for the
  current fault

* Fixed issue with the display of registers in their "natural" format
  in the Register view. This in particular means that floating point
  registers will now be displayed in floating point format by default
  instead of hex

* Fixed issue with display of Registers View when the target is
  running

* Fixed issue with the handling of Peripherals View for SDK-based
  multicore MCUs

* Fixed issue with "Resume All" button being enabled even when all
  debug sessions are already running

* Enhanced Global Variables view to allow live variables update to
  be started/stopped whilst target is paused

* Fixed issue with LinkServer debug which could cause connection
  failures when debugging MCUs (such as LPC8xx) which use the "-vc"



  debug option by default

* Fixed issue with LinkServer flash driver handling causing
  unnecessary memory accesses to be made, which could cause flash
  programming failures with some very RAM limited MCUs

* Fixed issue with LinkServer related to debugging applications in
  RAM, which could prevent correct setting of breakpoints

* Fixed issue with LinkServer attaching to projects running in RAM

* Improved LinkServer debug connections to RT10xx devices to avoid
  occasional "wire ack" fault that could occur when resetting MCU
  at the end of flash programming

* LinkServer debug connections now default to using the same
  Peripheral View service as used by SEGGER and P&E debug
  connections. The LinkServer native service can currently be
  reenabled via a preference, though this functionality will be
  removed in a future release

* Fixed issue that could cause LinkServer debug to occasionally
  slow down

* Improved LinkServer command line programming stability

* IDE now displays double precision registers in Register View
  with SEGGER and P&E Micro debug connections by default (where
  available on MCU)

* Upgraded to a later version of the P&E Micro plugin (v3.9.9)

* Upgraded to a later version of the SEGGER software (v6.42b)

=========================
Version 10.3.0 (Dec 2018)
=========================

* Major restructure of product installation structure to allow future
  minor product updates to be potentially delivered via Eclipse
  Software Update mechanism

* Upgraded supplied GNU ARM Embedded Toolchain to GCC7 2018q2-update

* Added support for MCUXpresso SDK v2.5.0

* Upgraded integrated version of MCUXpresso Config Tools to v5

* IDE now provides a workspace preference to allow the location of



  the SDK Drag&Drop installation folder to be changed. However by
  default a central 'mcuxpresso' folder is still used. Current
  install location label displayed in the "Installed SDKs" View

* IDE now generates part support information from installed SDKs
  into the workspace rather than into a central 'mcuxpresso' folder,
  improving behavior when multiple IDE instances are being used

* New implementation of the "Registers" View, allowing
  categorisation of certain registers groups, as well as providing
  access to additional CPU registers for P&E and SEGGER debug
  connections

* New "Faults" view compatible with LinkServer, P&E and SEGGER
  debug connections implemented (replacing the previous "vectpc"
  pseudo-register in Registers view for LinkServer debug
  connections). This view provides a decoding of the Cortex-M
  cpu's fault registers and stack backtrace to assist the user
  in tracking down the cause of hard faults and other processor
  exceptions

* SWO Trace now supported via SEGGER J-Link and P&E Micro debug
  probes (in addition to LinkServer LPC-Link2 debug connections).
  Note that only recent versions of P&E probes support SWO

* NXP LPC-LINK2 CMSIS-DAP firmware soft-loaded by IDE updated to
  v5.224, providing noticeable performance improvements over
  previous v5.183. For standard (debug+SWO) firmware, flash
  programming speed increases of typically >10% along with
  increases in SWO trace speed. For Non-bridged firmware
  (debug only), flash programming speed increases of typically >20%

* Project Explorer View enhanced to emphasise currently selected
  project, along with displaying its current build configuration

* Editing Memory Configuration for projects is now done in place
  rather than spawning separate editing dialog

* IDE now only creates a debug launch configuration for the current
  build configuration when a project is debugged (if one does not
  yet exist), rather than for all build configurations

* New SDK creator wizard to create a "board SDK" from an existing
  project (with settings modified using the MCUXpresso Config Tools).
  This "board SDK" can then be used to create new projects for
  custom boards

* Package associated with an SDK project can now be modified via
  the MCU entry of the project's "Project Settings" virtual nodes
  in the Project Explorer view



* IDE now supports additional build configurations being specified
  in SDK example definition files

* Added Linux Tools Libhover to preinstalled plugins (providing
  tooltips for standard C library calls)

* Upgraded to a later version of the P&E Micro plugin (v3.8.3)

* Upgraded to a later version of the SEGGER software (v6.40)

* Updated FreeRTOS TAD plugin to v1.0.8
   - Support heap using Newlib (identified as heap #6)
   - Support FreeRTOS 10.1.1
   - Fix highlight of free section in Heap Usage view

* Windows version of IDE now uses "busybox" (from "GNU MCU Eclipse
  Windows Build Tools" project) , to provide a Unix-like layer for
  GCC tools to run under, rather than the "msys" package used by
  previous releases

* Modified order of entries added to local shell's path when
  building projects under Windows - providing small improvement in
  build speeds

* Additional LinkServer flash drivers provided for RT1060 and RT1064

* Preliminary LinkServer support for LPC55xx devices

* Added basic support for Cortex-M33 secure projects

* Added support for Cortex-M33 No DSP variant

* LinkServer debug executable now allows probe selection by serial
  number (mainly intended for command line flash programming
  operations)

* Redlib updates
  - Fixed snprintf() / vsnprintf() to prevent hard fault when
    NULL buffer passed
  - Fixed issue with number sequences generated by rand()

* Made ordering of C Libraries in drop down lists consistant across
  various menus

* Allow user to only choose valid FPU settings in the Architecture
  tab of Project Settings

* "Quick Settings" option now allows reconfiguring multiple projects
  (where projects have compatible settings)



* Fixed issue that could cause a project to lose modifications
  to its memory configuration

* Grouped SDK actions under new "SDK Management" entry of Project
  Explorer popup menu

* Fixed issue that could cause a project's list of associated SDK
  components to be lost

* Fixed issue with sorting of boards in SDK project wizards not
  taking any current selection into account

* Fixed issue with default peripherals.c/h files being automatically
  (and incorrectly) added during SDK example import

* Fixed issue with Import of >1 SDK examples sometimes failing to
  correctly pickup some IDE default settings

* Fixed issue with SDK Project Component Manager when adding
  components with conditional sources to an existing project

* Improved handling of C library family setting when importing
  multiple SDK examples

* Fixed issue that could cause the IDE to block if requested to
  change the SDK associated with a project

* Fixed issue with SDKs become unusable after cancelling an
  unzipping operation

* Fixed issue with SDK New Project Wizard when no board selected which
  could cause wrong header files to be generated

* Fixed issue with SDK New Project Wizard such that main.c file always
  included the BOARD_InitDebugConsole() call even when the debug
  console component is not selected

* Fixed issue with handling of derived peripherals containing '_'
  in name

* Implemented partial workaround for underlying Eclipse issue that
  can cause a "Target Not Available" dialog if starting a debug
  session with the Disassembly view open

* Fixed issue with SEGGER launch configurations failing to reset
  MCU after programming flash

* Fixed issue with launch configurations created using standard
  Eclipse functionality, as opposed to automatically created using



  MCUXpresso IDE

* Enhanced handling of additional bespoke launch configurations

* Fixed issue with sorting in Probe selection dialog

* Fixed long standing issue with LinkServer launch configuration
  tabs changing order every time the launch config editor is open

* Fixed issue that could cause the launch configuration selection
  dialog to be displayed twice in some circumstances

* Fixed longstanding issue with that prevented Instruction Trace and
  SWO Trace being used together

* Fixed issue with Instruction Trace Config view not correctly
  loading saved configuration files

* GUI Flash Tool will now automatically select the highlighted
  binary file from Project Explorer View

=========================
Version 10.2.1 (Jul 2018)
=========================

* Fixed issue in New Project Wizard when switching between a board
  and a generic device (or vice versa)

* Fixed issue with floating point settings when importing SDK
  example projects for Cortex-M7 based MCUs

* Fixed issue with notification of missing dependencies when
  Add/Remove Component used with SDK v2.4.0 packages

* Improved options to handle part selection when project importing
  in cases where associated SDK is not installed

* Fixed issue which could prevent a renamed project from being
  debugged in some circumstances

* Resolved various issues with user interface of GUI Flash Tool

* Resolved issue with workspace preferences when trying to configure
  the Debug perspective to be used for debugging projects
  (instead of the default Develop perspective)

* Improved reliability of LinkServer debug sessions via enhancements
  to the way the IDE connects to the server process, as well as
  enhancements in the server itself



* Improved the IDE's display of the LinkServer "RedlinkServer"
  console

 * Fixed issue with LinkServer "Disconnect behavior" always using
  "cont", even when configured to use another disconnect option

* Option to terminate debug session added to IDE's LinkServer error
  dialog

* Fixed issue with handling of number formats for entries in
  Global Variables view

* Live Global Variable graphing no longer inserts spurious zero
  entry when target paused

* Fixed issue with enumerated bitfield handling in the Peripheral
  Register viewer

* Fixed issue with display of PriMask, BasePri, FaultMask and
  Control special registers in Registers view for LinkServer
  debug sessions. This change also now allows these registers
  to be edited

* Fixed issue with LinkServer erroneously setting VTOR in some
  circumstances after programming flash

* Fixed issue with zoom function on SWO Interrupt Trace view

* Fixed issue with Instruction Trace view, which could prevent
  profile information being displayed in source and disassembly
  views in some circumstances

* Fixed issue with Instruction Trace Config view, which prevented
  a modified configuration being saved

* Preliminary LinkServer SPI flash drivers that self-configure
  using JEDEC SFDP information read from the device are now
  included for i.MX RT1020 (QSPI) and RT1050 (QSPI and Hyperflash)

* Example device specific flash driver projects provided for
  i.MX RT1020 and RT1050. These can be used as a starting point for
  writing flash drivers for custom boards fitted with flash
  devices that do not support SFDP information

* Updated FreeRTOS TAD plugin to v1.0.6
   - Fixed issues with Pause button
   - Added more verbose log for determining heap type
   - Removed problematic heap identification from available
     variables



* Fixed issue which prevented the P&E Micro plugin updating from
  the P&E update server

* Upgraded to a later version of the P&E Micro plugin (v3.5.6)

* Upgraded to a later version of the SEGGER software (v6.32h)

=========================
Version 10.2.0 (May 2018)
=========================

* Upgraded Eclipse to Oxygen.3a / CDT 9.4.3. Amongst other
  improvements, this typically delivers a noticeable increase in
  build speeds

* Upgraded supplied GNU ARM Embedded Toolchain to GCC7(2017q4-major)

* Upgraded integrated version of MCUXpresso Config Tools to v4.1

* Pro Edition discontinued. All IDE functionality now enabled out of
  the box without any further activation or purchase

* Mac OS X version of product now fully 64-bit

* Quickstart Panel redesigned and now provides direct access to
  various operations for specific debug solutions

* Added support for project Virtual Nodes in Project Explorer View,
  providing improved access to project information and settings

* Added support for MCUXpresso SDK v2.4.0

* Improved handling of relationship between a project and its
  associated SDK package, for instance allowing user to select an
  appropriate, alternate installed SDK package if the originally
  associated SDK is no longer installed

* Fixed issue with handling of non-Latin characters in username
  when creating SDK support folders

* SDK-based projects can now be converted to have ‘local SDK part
  support’, allowing improved project sharing (such projects no
  longer require the full associated SDK to be installed in order
  to build/debug)

* SDK Documentation now accessible from within Installed SDKs View

* Enhanced accessibility of SDK Manifest information directly from



  within IDE Views

* Naming scheme used when importing SDK example projects simplified,
  leading to shorter, more legible filenames (also helping to
  avoid filename length issues when building projects on Windows)

* Include paths added on SDK project creation are now created
  project relative (reducing the size of the -I options passed to
  gcc), except in the case where "copy sources" is deselected.

* Projects can now be imported into a Workspace by dragging and
  dropping a folder (or zip) containing one or more projects into
  the Project Explorer View

* Projects can also be exported by dragging from the Project
  Explorer View directly to an OS filer window

* Added support for refreshing projects to pull in files from
  a newer SDK than the one they were created with

* Enhanced display of SDK components in dialogs such as the New
  Project Wizard by allowing full-height scalable columns

* Fixed a minor issue with semihosting hard fault handler generated
  by project wizards, failing to set return value correctly

* Fixed an issue with the SDK new project wizard failing to set
  some compiler options correctly, meaning that project build size
  increased, as unused functions in project sources were not removed
  by the linker by default

* Projects created against SDK v2.4.0 packages will now link with
  the "--sort-section=alignment" option (generally, unless
  overridden by SDK settings)

* Improved structure and content of static library projects created
  by the SDK new project wizard

* Enhanced support for project local LinkServer debug scripts

* Added support for project local LinkServer flash drivers

* Global data placement override added to Managed Linker Script
  properties, allowing global data to be located in RAM regions
  other than the first listed in the memory configuration

* Managed Linker Script properties enhanced to allow user-specified
  input sections to be listed in specific memory regions in
  the generated linker script



* Managed Linker Script page in Project Properties reorganized to
  give better layout of related options

* Fixed an issue with validation of heap and stack region sizes on
  the Managed Linker Script page in Project Properties

* Support for "Plain load images" added to the managed linker script
  mechanism - for use with LPC540xx MCUs. This allows an image to
  be placed into flash but relocated to RAM by the bootrom for
  execution

* Instruction Trace functionality now available with P&E Micro and
  SEGGER debug connections, as well as with LinkServer connections

* New "GUI Flash Tool", replacing and extending the functionality
  previously provided by the LinkServer GUI Flash Programmer. This
  also supports use with P&E Micro and SEGGER debug connections, as
  well as LinkServer connections

* Global Variables View now offers the ability, with LinkServer
  debug connections, to display a live trace of values, either as
  text or graphically

* Memory addresses can now be added as expressions to the Global
  Variables View

* Fixed various issues with the Peripheral Register viewer, including
  incorrect display of peripherals defined using the SVD "cluster"
  tag, and failure to display certain bitfields correctly in some
  circumstances. Also, bitfield display ordering within registers is
  now identical for all probe types

* Enhanced filter mechanism provided by the Peripheral Register viewer

* For LinkServer and SEGGER debug connections, a hardware breakpoint
  is now used by default (where Cortex-M hardware allows) for the
  default temporary breakpoint on main(), improving support for
  debugging images that are relocated into RAM at boot time

* Fixed an issue with LinkServer debug connections, which caused the
  IDE's Debug View to always display "(Stopped)" in thread status
  (even when running) when FreeRTOS thread awareness was not in use

* Fixed an issue with LinkServer's "vectpc" pseudo-register in the
  Register View (used to provide CPU status information when
  exceptions such as hard faults are triggered)

* Further improvements to the performance of standard LinkServer
  semihosting



* "Mailbox semihosting" mechanism now available for images linked with
  the Redlib C library and debugged via a LinkServer debug connection.
  This offers a major increase in bandwidth / performance compared to
  standard, breakpoint-based semihosting, as the target is no longer
  halted to transfer data. It requires the image to be linked against
  a new Redlib variant, and comes at the cost of a small increase in
  code size and RAM requirements

* New Terminal View available, allowing UART output from target MCU
  to be displayed within the IDE rather than requiring a separate host
  terminal application

* Removed automatic definition of bitband memory aliases in the
  LinkServer debug connection on Cortex-M3/M4/M7 parts, as
  these could prevent debugging in situations where a project
  contained similar regions in its memory configuration

* LinkServer SPIFI flash drivers that self-configure using JEDEC
  SFDP information read from the device are now included for the
  LPC18xx, LPC43xx, LPC546xx, and LPC540xx families

* LinkServer QSPI flash driver provided for MIMXRT1050-EVK and
  EVKB boards. Note that these boards require modification to
  use QSPI device rather than default Hyperflash device

* Upgraded to a later version of the P&E Micro plugin (v3.5.3)

* Upgraded to a later version of the SEGGER software (v6.32a)

* Updated SEGGER gdbserver detection on Mac / Linux to take into
  account changes made by SEGGER to filenames on these platforms
  (in J-Link v6.30 and later)

* Added the LPC804 MCU to pre-installed part support

* Extended the Eclipse headless build mechanism to use the environment
  variable "MCUXPRESSOIDE_SDK_INSTALL" to point to the SDK install
  directory (primarily to support use of build servers)

* Optional, anonymous usage information is now collected by the main
  IDE, as well as the integrated Config Tools

* Updated the FreeRTOS TAD plugin to v1.0.4. Changes include:
  - Fixed Heap 5 issue with displaying large free blocks
  - Fixed Heap 5 issue with calculating wrong size of heap
  - Fixed issue with task stack showing overflow when usStackDepth
    is greater than 2048
  - Fixed a heap identification issue
  - Fixed an issue with Queue View when no queue has been registered



=========================
Version 10.1.1 (Dec 2017)
=========================

* Fixed an issue seen when importing a single SDK example, in which
  example-specific settings could in some circumstances be overridden
  by IDE defaults

* Fixed an issue with SDK example import failing to set the correct
  memory definition in a generated project, in a situation where there
  is an example-specific memory configuration and also one in the
  manifest for the board itself

=========================
Version 10.1.0 (Nov 2017)
=========================

* MCUXpresso Config Tools now integrated within the IDE, for use
  with SDK based projects

* Upgraded supplied GNU ARM Embedded Toolchain to GCC 6 update 2

* Increased default max heap space of Eclipse environment requested
  by the IDE

* Additional Eclipse Features supplied within IDE installation:
  - Eclipse Marketplace Client
  - Eclipse XML Editors and Tools
  - Eclipse XPath Developer Tools
  - Eclipse XSL Developer Tools

* Fixed issue with Memory Configuration Editor when all memory blocks
  deleted

* Parallel building of projects now also enabled for "release" build
  configuration (previously this was only done for "debug" builds)

* Managed linker scripts now generate _HeapSize and _StackSize
  symbols when configured for "MCUXpresso Style" Heap and Stack
  placement

* Managed linker scripts now generate _image_start, _image_end and
  _image_size symbols giving location and size of main text block
  (including initial values of RW data sections)

* Added "Information" option to Binary Utilities menu to run
  arm-eabi-readelf utility

* Enhancements to IDE's SDK handling for SDK v2.3.0 packages and
  manifests



* SDK default folder mechanism updated to provide a versioning
  subdirectory, to prevent clash of installed SDKs if IDE v10.0.x
  is used after SDKs are installed into IDE v10.1.0

* Improvements to Installed SDKs View. IDE will now show which
  manifest is in use and the handling of decorators (icons) to
  reflect SDK state has been enhanced

* Improved handling of imported project when no matching SDK part
  support installed

* Provided Delete option for when a newer version of a specific SDK
  is imported and replaced an older version

* New SDK Add/Remove Component Manager allowing addition and removal
  of drivers, RTOS and  many Middleware components to existing
  projects. Note some functionality only available when used with
  SDK v2.3.0 packages

* SDK new project wizard now provides Middleware component selection
 (for use with SDK v2.3.0 packages)

* IDE now supports SDK component categorization (where provided by
  SDK)

* Projects using linked references to SDKs sources now export with
  only relative include paths (to an environment variable) so
  simplifying project sharing

* Improved interaction between SDK and IDE over project settings
  (for SDK v2.3.0 packages). This allows, for instance, better
  syncronization in the Advanced setting page when importing
  examples. Also allows for projects which require specific settings
  such as Newlib or floating point printf

* Enhancements to the SDK Wizard Advanced Setting page, including
   - Redirect printf/scanf to ITM option now disabled for Cortex-M0+
     cpu in multicore MCUs
   - C++ project selection in project wizard now prevents selection
     of Redlib

* Improved multicore SDK project handling, including enhancements
  within the SDK new project and import example(s) wizards

* Enhancements to SDK handling allowing removal of "Reload" part
  support function, leaving only "Recreate"

* Filter functionality for Importing SDK Examples enhanced so
  that now filters on any part of the example path, not just the



  leaf name of the example

* New Project Wizard improved to better handle situation where user
  uses "back" button

* Fixed issue with export of examples.xml file

* Fixed issue that in some circumstances importing multiple examples
  could cause some projects to fail to build

* Changes made to the SDK new project wizard's default board button
  position and its selection

* Pressing SHIFT at same time as clicking on the Quickstart Panel's
  Debug option will now force a debug probe re-discovery

* Fixed issue with IDE failing to display Peripheral View for a
  peripheral which is enabled but where some, but not all, of the
  registers are not accessible (for instance SPI peripheral in
  slave mode on Kinetis parts)

* Added alternate ("non-enhanced") Peripheral View service for
  use with LinkServer that works in the same way as the Peripheral
  View services provided for SEGGER and P&E debug connections. This
  is disabled (via a preference) by default, as it is largely
  intended for internal testing purposes.

* Fixed issues with Peripheral View for SEGGER and P&E debug
  probes, plus LinkServer in non-enhanced peripheral mode:
  - LPC17xx and LPC12xx peripherals can now be displayed
  - Display state no longer lost when execution restarted
  - Selecting peripheral register value no longer triggers an error

* Semihosting HardFault handler now automatically included in
  new/imported SDK projects. This allows semihosted applications to
  continue execution without debug tools attached

* AllStop mode option is now saved if a LinkServer launch
  configuration is created manually for the connected probe (as
  opposed to using the Quickstart Panel Debug option)

* LinkServer multicore debug auto-core select now works correctly
  for Cortex-M0+ core on LPC541xx MCUs (using pre-installed part
  support)

* Fixed issue with deleting JTAG/SWD configurations (for LinkServer
  connections, typically to multicore MCUs) actually deleting the
  launch configuration files.

* Fixed issue with IDE's Register View when debugging multicore MCUs



  such that it displayed Cortex-M4 registers, but referenced them as
  being for the Cortex-M0+

* For LinkServer debug sessions, failed debug sessions now report
  specific session that failed (useful when debugging more than one
  target)

* Various functional enhancements to LinkServer GUI flash
  programmer. Dialog window also now resizable.

* Fixed LinkServer (redlinkserver) script TIME function on Mac and
  Linux. Also corrected time resolution for this function on all 3
  host platforms

* Fixed clock setup issue with LinkServer LPC5411x and LPC546xx
  flash drivers, which could occasionally cause programming failures.
  This fix also provides noticeable increase in programming
  performance on these parts

* Upgraded to a later version of the SEGGER software (v6.20d)

* Upgraded to a later version of the P&E Micro plugin (v3.1.8)

* Enhanced gdbserver console for SEGGER debug connection to quote
  invoked J-Link command when path contains spaces

* Added support for Environment variables in JLink options

* Improved SEGGER server handling to link consoles created to
  project being debugged

* Improved SEGGER debug reset handling

* Improved automatic LPC MCU part matching mechanism for P&E Micro
  debug launch configurations

* Added LPC802 MCU to pre-installed part support

* Added LPC8N04 MCU to pre-installed part support

=========================
Version 10.0.2 (Jul 2017)
=========================

* Fixed an issue where an MCU provided in both SDK and
  pre-installed support (e.g. LPC5411x) could in some
  circumstances erroneously reselect part support for a project
  from the wrong source



* Solved an issue with attempting to install a non-IDE-compatible
  SDK into a non-default location

* Solved some issues with creating projects in non-default
  locations

* Fixed an issue with the Properties View displaying information
  for the wrong device in some circumstances (for pre-installed
  parts)

* Fixed an issue with incorrect dependency selection in project
  wizards in some circumstances when switching between boards

* It is now possible to create makefile projects for SDK MCUs

* Enhanced the Memory Configuration Editor to give an error if
  there is no RAM defined for a project

* Enhanced the Heap & Stack Editor to allow heap size to be set
  to zero

* Added a "Create Srecord" option to the Binary Utilities menu

* Implemented a port auto-discovery mechanism for LinkServer,
  SEGGER and P&E Micro debug sessions, to improve concurrent
  debug session behavior

* Improved editing of launch configurations via double-click, and
  also improved their presentation in the Project Explorer

* Fixed some issues with manually generated launch configurations
  (including non-stop setting)

* Added probe icons in the "Launch Configuration Selection" dialog

* Fixed a failure to display registers for certain peripherals
  in Peripheral View for SDK-based MCUs

* Resolved an issue with Peripherals failing to display if a '_'
  character was used in a register name

* Fixed some issues with the semihosting console:
  - Space/newline characters were occasionally lost when printing
    only a single character
  - Empty strings were sometimes mishandled

* Fixed an issue with "Terminate All" in some circumstances when
  multiple debug connections were active

* Improved synchronization of the state of MUCXpresso IDE's blue



  debug button on the toolbar with the one on the Quickstart
  Panel, particularly when moving between tabs

* Stopped the Registers View triggering a null pointer error when
  an n/a value was clicked

* Fixed a LinkServer issue with the setting of watchpoints when
  debugging Cortex-M0/M0+ based MCUs

* Fixed an issue with auto-core selection when debugging
  triple-core LPC43xx devices

* Fixed an issue with display of performance counters in
  LinkServer SWO Trace

* LinkServer FreeRTOS Thread Aware Debug is now only available in
  all-stop debug connections, not in non-stop. However, FreeRTOS
  TAD Views are still available for non-stop connections

* Fixed an issue with LinkServer debug connections losing target
  control when an attempt was made to use more hardware
  breakpoint units than were implemented by the MCU

* Fixed an issue where peripherals could fail to be displayed in
  LinkServer debug connections in some circumstances

* Enhanced LinkServer support for debugging RAM-only projects

* Reduced the startup time for LinkServer debug sessions

* Improved the performance of LinkServer semihosting

* Enhanced LinkServer to allow restricted parsing
  of the MCU debug AP bus, allowing support for MCUs with
  incomplete Coresight implementations
  - Debug of Kinetis KL28 MCUs is now supported via LinkServer

* Fixed an issue with MCUXpresso IDE mistakenly attempting to use
  JTAG instead of SWD connections for certain CMSIS-DAP probes
  with multicore MCUs that have no JTAG support in hardware

* Fixed an issue with MCUXpresso IDE in some circumstances trying
  to make a LinkServer multicore debug connection to a slave core
  without correctly selecting the core

* Fixed the Save button for the LinkServer SWO Trace ITM console

* LinkServer no longer leaves the MCU's CPU in debug mode when
  terminating a debug connection (so semihosted I/O will now
  hard fault, rather than causing the CPU to enter debug)



* Made various improvements to the LinkServer GUI flash
  programmer

* Upgraded to a later version of the SEGGER software (v6.16b)

* Improved SEGGER support, including:
  - Support for concurrent debugging via multiple SEGGER probes
  - Improved SEGGER launch configuration UI, providing more
    options directly and adding a new Startup tab
  - Fixed an issue with terminating a debug session when multiple
    SEGGER debug sessions are active
  - Enhanced automatic part selection for SEGGER debug
    connections of pre-installed MCUs
  - Changed the SEGGER device dropdown to accept free-form text
  - Fixed an issue seen when debugging with an external SEGGER
    GDB server, which triggered telnet console issues
  - SEGGER server errors now appear in the dialog when debug
    connections fail
  - Fixed a server shutdown when a debug session was terminated
    to leave the board in a running state

* Upgraded to a later version of the P&E Micro plugin (v3.0.3)

* Improved P&E Micro support, including:
  - Support for concurrent debugging via multiple P&E Micro
    probes
  - Fixed an issue with the Quickstart Teminate/Build/Debug
    button when used with P&E Micro debug connections

* Various other bug-fixes and UI tweaks, including:
  - Quickstart Panel floating point options made device
    specific
  - Added a link to the Error Log View in the invalid SDK
    exception error dialog
  - Fixed a LinkServer semihosting input issue (e.g. scanf
    needing extra carriage returns)
  - Fixed an issue with handling the LPC5411x SDK versus
    preinstalled support board selection
  - Removed non-stop Probe Discovery options that had been
    presented for the LinkServer GUI Flash Programmer Mass erase
    function
  - Added an option to the Project Wizard to allow import of
    "miscellaneous" files from SDK project structure and SDK
    components into the generated project
  - Fixed an issue with library project creation pulling in
    startup code

* Changed the name of the Linux installer from .run to .bin
  to avoid issues with the Flexera download system



* Fixed the Linux P&E Micro udev rules setup for users who have
  Kinetis Design Studio installed

* Documentation fixes and minor enhancements to reflect product
  changes

* Enhancements to LPC84x support, including ROM divide support
  in the new project wizard

* Added PN7xxxx to the list of pre-installed MCUs

* Added QN9080-specific LinkServer debug support

=========================
Version 10.0.0 (Mar 2017)
=========================

* First release


